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GEOMETRY CREATION TUTORIALS
These tutorials are designed to introduce you to the concepts associated with Geometry
Creation. As none of these tutorials involvemachining, these are excellent places to start if you
need to understand the basic ideas surroundingGeometry beforemoving on tomachining
concepts. Wewill cover Free-FormExercises, Geometry Expert Exercises, and Combination
Exercises.
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FREE-FORM EXERCISES

The exercises contained in this chapter are designed to introduce the basic concepts of geometry
creation using the Free-FormCAD tools contained in the Geometry Creation palette. For the part
prints for the exercises, see “Part Prints” on page 158.

The first few exercises give very detailed step-by-step instructions for creating part geometry, while
the later exercises become less detailed. Exercises 1, 2, and 5 are done using theMill module,
while Exercises 3 and 4 are done using the Lathemodule. Because these exercises deal with only
geometry creation (and not machining), they can be created using either module. The only
differenceswill be in the setup of the document. It is recommended that you read through the
Getting Startedmanual before attempting these tutorials.

Exercise 1: Shapes and Connectors

This exercise creates a very simple shape to demonstrate how the Free-FormCAD tools create
and connect geometry. There is no example part print at the end of themanual for this exercise.

Creating Shapes

Part Setup

Create the Part

1. Click the Documents button in the Toolbar command group.

This dialog contains file management options aswell as general information about the part,
such as the type of machine being used, stockmeasurements andmaterial information.
Typically, when creating a part, you wouldmodify these settings at this point to reflect your
desired options. For this tutorial, we will configure these settings in the next section.
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Configure Machine Information

2. Click theNew button.
Type Shapes in the
File name text box.

3. Save the tutorial part in a convenient location. The parts created in thismanual will be used in



Creating Shapes

6

the other manuals.

4. Click the Save button.

5. In theMachine list, select 3 Axis Vertical Mill. TheMaterial information is fully covered in the
Getting Startedmanual. For this exercise,
match theMaterial settings shown.

6. Select inch for themeasurement type.

7. Enter the values as displayed above.

8. Clearance Plane values are explained in the
Machining chapter and tutorials of theMill
and Lathemanuals.

Becausemachining processeswill not be
created in this exercise, the stock and
clearance values input into this dialog are
merely to provide a stock outline to contain
the shape wewill create.

9. Type “This is the first tutorial
part” in the Comment text tab.

If a comment is entered in the text tab, it will
appear in theOpen dialog when a part is
selected. This comment will also appear in
the G-code. A part comment is not necessary
but is often helpful in identifying parts.

10. Close the Documents dialog. You can press + if you wish to use the
keyboard shortcut.

To finish this section, wemust ensure that your view accurately depicts the steps in the
remainder of the tutorial. This can be accomplished through either keyboard shortcuts, the View
Menu (which lists the keyboard shortcut for each selection) or the View Palette.

To use keyboard shortcuts, press + then + .

or
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To use the View Menu, select View home

then View Unzoom.

or

Click the view button in the Toolbar command group to open
the view palette. Press the Home, then the No Zoom icons on
the palette.

The options available in theMachine list are dependent on themodules installed.
The selectionmade for theMachine Type sets theMDD (Machine Definition
Document) for the current part. Selecting the correct MDD is important because it
affects how the part will be drawn andmachined.

Geometry Basics

Axis Lines

Open theGeometry
palette. or
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1. Open the Line sub-palette.

Please note that all buttons in the palettes can be selected by pressing the number on your
keyboard that corresponds to the button’s position in the palette. For example, the Line sub-

palette can be accessed by pressing as the Line sub-palette is the second button.

2. Select Axis line.

3. Select the vertical linemode.

Wewill draw the first line at X -1 and Z
0.

4. Click theMultiple Lines button.

TheMultiple lines button tells the
system that you wish to create
more of this type of line. The first
line will be drawn as shown.

The colors associated with lines/backgrounds can be different depending on your settings. Here
the default color of any unconnected geometry line is yellow. 

5. Switch to the horizontal line
mode.

This will change the X value to a Y. Since the value for the horizontal line is the same, nothing
needs to change. 
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6. Click the Single Line button.

If you accidentally press Enter or the
Multiple feature when you are done, you
can press the Esc key or Return button.

Tangent Circle to Line

1. Return to theMain Geometry Palette. (press the Esc key or Return button )

2. Open the Circle sub-palette.

3. Select the two lines you have just created.

Theywill change to a dark blue color.

A modifier key such as Shift or Ctrl is not
required when sub-palettes are open. The
selectionmode is designated with the white
arrow pointer.

4. Input the value shown.
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The order in which the lines appear in the selection boxes (L) in the dialog is determined by the
order in which you selected them. In this exercise, the order is not critical.

5. Click the Single Circle button.

All possible circle tangencieswill be drawn, allowing you to select whichever circle is necessary
to create the required part geometry. If more than one feature is selected, no automatic
connection will occur.

6. Select the upper right
circle shown.

The four possible circle
tangencies to the lines
are drawn.

Once a feature is selected, theOK button becomes active.

7. Click theOK button.

When any button is active and waiting for a response you can use the key or the space bar
rather than using themouse.

The circle trims to an arc creating
2 blue square points called
connector points.

Connector points designate connections between elements. The systemwill create trim points
or connector points (blue squares) rather than points (yellow round dots) whenever possible.
Each type is interchangeable aswewill demonstrate later on in this tutorial.

Explicit Point
Return to theMain Geometry Palette.

1. Open the Point sub-palette.
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2. Select Explicit point. An Explicit point requires you to define
the point’s location.

3. Input the value shown.

4. Click the Single Point
button.

You will notice that the button is highlighted and
therefore active (light blue band around it). Thismeans
you can also select this by pressing the space bar or

key.

Pressing + or
+spacewill change themode to
"multiple" and will create the
feature, remaining on the same
dialog to allow you to create
another point.

Angled Line Through a Point

1. From theMain Geometry Palette, open the Line sub-palette.

2. Select Point Angle line.

3. Click (select) the point
we just created. Input the value shown.
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4. Click theMultiple Lines button. Alternatively you can press + .

Your screen will look like this

5. Change the value as shown.

6. Click the Single Line
button.

In this case a connector
point is not created.We
will need tomanually
connect the intersection
of the angled lines.
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Connecting Lines - 1

1. Ctrl+click anywhere along each of
the angled lines in the upper right of the
shape.

The lineswill change to a dashed blue.

The Ctrl key activates the selectionmode (white arrow).

2. Click the Connect-Disconnect button on theMain Geometry palette.

(Or you can click the right mouse button which brings up a pulldownmenu - choose
Connect/Disconnect.)

The plain point (circle) is converted to a connector (square.) Neither of the lines that intersect at
that point trim because each has only one connector point.

Connecting Lines - 2

1. From theMain Geometry Palette, open the Point sub-palette.

2. Select the two lines in the upper left
of the shape.

The lineswill change to a dashed
blue.

We are again in selectionmode. Selecting two lineswhile the Point sub-palette is open will open
the line-line intersection point dialog that will create a point and connect the lines.
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3. Click theMultiple Points
button.

The lines become light blue (the
default color for connected
geometry) and trim because they
now have two connector points.

4. Select the last two unconnected
lines (bottom right).

5. Click the Single Point button. The shape is now closed.

Circle with Radius and Center Point

1. Open the Circle sub-palette.

2. Select Radius & Center Point.

3. Select the point shown (top right).

4. Input the value shown.
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5. Click the Single Circle button.

The circle is untrimmed, indicating
there are no connections - the lines
that it intersects already have two
connector points each.

Wewant this new circle to be the corner of our shape. There are twomethods of achieving this,
one uses the Combine function to add the shapes together, the other uses the Connect-
Disconnect function. First we will use Connect-Disconnect.

Connecting a Circle and Line - 1

Firstly, the point at the intersection of the lines (the center point of the circle) must be
disconnected.

A quick way to enter data into a text box is by using the interrogation cursor. If
there is a reference value, Alt+click the reference geometry to load the data
into the selected text box. Additionally, all the usable data for the dialog can be
loaded with Shift+Alt+click.

Breaking Connections - 1
Select the center-point of the circle we just created.

1. Click the Connect-Disconnect button.
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The point changes from a
blue square to yellow round
point. The lines also
become untrimmed.

While the Connect/Disconnect button is a perfectly valid way to disconnect the lines, in this
exercise wewon’t need the center point. As such, we will use a slightly different method.

2. Choose Edit Undo. + This will reconnect the lines.

Breaking Connections - 2

Delete the center point of
the circle.

Select the center point,

press

The same disconnection happens
but there is no longer a center
point. We could easily recover this
point using the Line-Line
intersection point.

Connecting

1. Open the Point sub-palette.

2. Select the line and circle as shown.

When a circle is intersected and not tangent to a line,
the 2 intersecting points will highlight for you to select
the features necessary for the part. One or both of the
points can be selected for incorporation into the part
geometry.

3. Click the Single Point button. Two points are highlighted where the
line intersects the circle.
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4. Select the left point as shown.

5. Click theOK button.

The point becomes a connector, and
the top line trims.

6. Select the unconnected circle and
vertical line and click the Connect-
Disconnect button.

The two points of intersection are
displayed.

7. Select the bottom point.
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8. Click theOK button.

The resulting closed shape will look
like this:

Reversing Arcs

By default, all circles trim to an arc of less than 180° when they have two connector points. In
this case, we want the arc that is greater than 180°.

1. Select the arc.

2. ChooseModify > Reverse Arc +

The arc is now reversed.

Connecting a Circle and Line - 2

Thismethod of adding shapes together uses the Combine Shapes function.
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1. Step back to this stage of the
construction using Edit>Undo.

2. Double-click one of the blue lines to select themain shape, then Ctrl-click the circle.

In the Geometry Palette select the Shape sub-menu and then Combine Shapes .

3. Click the Union button.

The shapes combine.

Terminating Points

There is a third type of point called a terminator. A terminator is graphically shown as a yellow
square. A terminator is similar to a connector point in that it connects a feature to itself.
Terminators are useful in finishing an open shape.
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1. Delete the arc.

The two lines un-trim.

2. Select the point shown and Ctrl+click
the line that intersects it.

In order to create terminators, a point and
the feature that goes through that point
must be selected.

3. Click the Connect-Disconnect button.

The point becomes a square,
indicating a terminator point. The
line turns blue and trims to signify
that it is fully connected.

4. Select the center-point of the circle we just created.

5. Select the other point and untrimmed line.

6. Click the Connect-Disconnect button.
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The geometry is now a fully-
trimmed open shape.

7. Click File> Save to save your work.

Dimension Palette
We can now add dimensions to the shape we just created.

1. Click the Dimension Palette command.

To begin with wewill set the font and size of the dimensions for this part.

2. Right-click
anywhere within
the title bar of the
Dimensions
Palette, and click
Set Font.

Change the font size to 16. This changes
all existing and subsequent annotations,
and controls the size of both the
dimensions and any text within this file.

ClickOK to accept.
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3. Click the Point to point dimension button. This places a linear dimension between two
selected points.
The command becomes highlighted in blue.

4. Click the point shown in the screenshot below to highlight it. Now press and hold the Ctrl key.
Hover your cursor over any of the other points in the part. You will notice the dimension between
two points will display in a light grey colour.

5. Hover the cursor over other points in the workspace until the dimension you require is displayed,
at which time, click the second point. The color will change to white, to indicate it is now added to
the part display.

6. Click the Angle Dimension command. This places a 2D angular dimension between two
selected lines.
You will note that the Point to point dimension commandwe used previously becomes
deselected, and the angle command is now highlighted in blue.

7. Click the line indicated by the red arrow below to highlight it and once again press and hold the
Ctrl key. Hover over any of the other lines to display the angle between them. (The closer to the
ends of the line, the smaller/larger the leader line will become.) Click the desired distance along
the second line to add the angle dimension.
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8. Finally, click and highlight the Text command.

You will notice that the cursor changes to a brown “I” insert cursor.

9. With the text command highlighted, click in the workspace where you wish text to appear, and
simply start typing.When you have finished typing, click away and the text command then
becomes deselected.

To delete an item

To delete a dimension or text, click and highlight it (It will change to a brown color.) If required,
press and hold the Ctrl key to click and select multiple items. Pressing the Del key on your
keyboard will then delete the highlighted item(s).

Moving existing text or dimensions

You canmove existing text or dimensionswithin the workspace.

Tomove text, Click, hold and drag the white text (a brown box appears) and drop the brown box
where you wish to reposition the text.

Tomove a dimension, click either the (white) leader line or the value and drag it to the required
position.

Exercise 2: Mill Tutorial

This exercise creates the geometry for the part we will machine in theMill manual.
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Setting up the Part

1. Open the Documents dialog (F1) .

2. Click theNew button.

3. Type “Mill Tutorial” in the File name text box.

4. Save this file where it can be easily accessed in the future. Wewill machine this part in theMill
manual.

5. Click the Save button.

Ensure theMachine list has a 3 Axis Vertical Mill.

6. Select the inchmeasurement type.

Input the values for the stock size
shown.

The information contained in the dialog can be changed at any time.

7. Close the Documents dialog.( + )

The preferred process to create the geometry for a particular part is to choose a starting location
and work in either a clockwise or counter-clockwise direction around the part. By using this
method, featureswill become connected at the first opportunity which simplifies geometry
creation.

Creating the Geometry

Multiple Explicit Points

1. Open theGeometry palette.

Wewill now create five Explicit points.

2. Open the Point sub-palette.
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3. Select Explicit point.

4. Input the coordinate values shown.

(This will create a point at 0,0 - you
may not be able to see it as it is hidden
by the axis lines)

5. Click theMultiple Points button..

6. Change the values and press Enter.

7. Change the values and press Enter.

8. Change the values and press Enter.

9. Change the coordinate values
shown..

10. Click the Single Point button.

If you accidently press Enter or theMultiple feature when you are done, you can press the Esc

key or Return button.
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You should now have the five
points shown. (The one under
the axis is hidden)

Radius and Center Point Circles

Wewill now create circles around each of the points.

1. Open the Circle sub-palette.

2. Select Radius & Center Point.

3. Select the point at the origin. (This is the first
point created at X0, Y0)

The CP text box displays a label identifying
the point selected as the center point of the
circle.

4. Input the value shown for the radius
(R2)

The system assigns a label to all geometry created. Geometry is defined by a letter (P for point, C
for circle, and L for line) and a number indicating the order of creation. These labels are
displayed with View > Labels or Ctrl+L. Many geometry dialogs display the label(s) for selected
geometry.
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Labels

1. Choose + ) or

All the points created have been
labeled. Labels can be turned on at any
time without affecting geometry
creation, and are especially helpful if
there are any connection problems.

2. Choose View labels again, to turn them off.

3. Click theMultiple Circles button.

This button functions in the sameway as theMultiple Points button. It allows for the creation of
more than one circle using the samemethod (in this case, selecting an existing point to act as
the center point, and then entering a radius value).
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4. Select the point shown.

5. Input the radius value shown.

6. Press the space bar.
This is the same as pressing Enter or the
Multiple Circles button.

7. Select the point shown and press
Enter.

The radius is the same for the next three circles, so there is no need to change the value.
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8. Select the point shown and press
Enter.

9. Select the point shown and
click the Single Circle
button.

We could have easily have defined the circles with descriptor center points; however, we will be
using some of the center points.

Line Tangent to Two Circles - 1

1. Open the Line sub-palette.
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2. Select the two circles shown.

(Remember the Ctrl key)

3. Click the Single Line button. All four lines that are tangent to the two
circles will appear.

4. Select the line shown and press
the space bar.

The line is added in blue and
connected between the two
circles.

Arc - Tangent to Two Circles - 1

1. Open the Circle sub-palette.
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2. Select the two circles shown.

(Remember the Ctrl key)

3. Input the radius value shown.

4. Click the Single Circle
button.

The eight circle tangencies
between the two circles are
displayed.

When the arc desired is larger than both the selected arcs there are eight possibilities. This can
look confusing so wewill zoom into the area wewant.

Drag amarquee around the tangencies to zoom in.

5. Select the circle shown.

6. Click theOK button.
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7. Click the View Command button.

The View palette is also referred to as the Trackball because of the trackball centerpiece. The
surrounding buttons change the view to standard views and other Viewmenu options. It also
contains an Unzoom button, which will redraw the screen to its original scale.

8. Click the Unzoom button or ( + )

9. Click the View Command button again to
close it.

10. Open the Circle sub-palette.

11. Select Radius & Center Point circle.

12. Select the point shown.

13. Input the radius and press Enter.

Tangent Line from Point - Circle

There are two possible lineswhen choosing the tangent line from a circle to a point.

1. Open the Line sub-palette.
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2. Select the point and inner circle shown
and press Enter.

3. Select the left line and click theOK
button.

Parallel Line

1. Open the Line sub-palette.

2. Select Parallel line.

3. Select the line we just created.

4. Input the value shown.

5. Click the Single Line button.
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6. Select the left line and pressOK.

Connecting a Circle and Line

1. Select the Line and the Circle
shown, click the
Connect/Disconnect button.

2. Select the bottom intersection
point.

3. Click theOK button. The circle will trim to an arc and become blue because it
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now has two connector points.

4. Connect the circle and line
shown.

Duplicating Geometry

1. Select the arc shown.

2. ChooseModify
Duplicate.

( + )
Duplicatewill create a duplicate of the selected
geometry.

3. Click somewhere off of the part to deselect the geometry.

Geometry sub-palettesmust not be open for deselecting in thismanner. If you have a white
arrow you are in selectionmode.

Line Tangent to Two Circles - 2

1. Open the Line sub-palette.
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2. Select the two circles shown.

3. Click the Single Line button.

4. Select the line shown and click theOK
button.

5. Open the Circle sub-palette.

Arc - Tangent to Two Circles - 2
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1. Click the two circles shown.

2. Input the values shown.

3. Click the Single Circle button.

In this case because the tangent radius is smaller than the largest circle and larger than the
distance + diameter of the smaller we only have two circles to choose from.

4. Select the bottom circle as shown.

5. Click theOK button.

Line Between Two Points

1. Open the Line sub-palette.
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2. Select the two points shown.

3. Click the Single Line button.

A vertical line is drawn through the two points.

4. Connect the circle and line
shown.

5. Select the top intersection point.
ClickOK.
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Reversing Arc Direction

1. Select the arc shown..

The smallest arc is the default.

2. ChooseModify
Reverse Arc.

We have chosen to use the
larger arc.

Click somewhere off of the
part to deselect the
geometry.

Arc - Tangent to a Line and Circle

1. Open the Circle sub-palette.

2. Select the line and circle shown.

3. Input the radius values shown.
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4. Click the Single Circle button.

5. Select the bottom right circle
shown.

6. Click theOK button.

Selecting a Shape

1. Double-click the line shown.

This will select all connected geometry to the line.

2. Click the Trash button.

Boss Geometry

1. Open the Point sub-palette.

2. Select Polar point.
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3. Select the point at the origin as shown.

4. Input the values shown.

5. Click the Single Point button.

This creates a point one inch from the selected point at an angle of 15°.

6. Open the Circle sub-palette.

7. Select Radius & Center Point circle.

8. Select the point at the origin as
shown.

9. Input the radius value shown.

10. Click theMultiple Circles button.
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11. Select the point shown.

12. Input the radius value shown.

13. Click the Single Circle button.

14. Open the Line sub-palette.

15. Select the two circles shown.

16. Click the Single Line button.



Exercise 3: Lathe Tutorial

43

17. Select the two outside lines
shown.

18. Click theOK button.

19. Select the arc shown.

20. ChooseModify Reverse Arc.

The geometry for this part is now complete. Make sure
that you save this on your computer where it can be
conveniently accessed.Wewill machine this part in the
Mill manual.

Exercise 3: Lathe Tutorial

This exercise creates the geometry for the part we will machine in the tutorial of the Lathemodule.

Geometry for Lathe Parts

Setting Up the Part

1. Open the Documents dialog.. or ( Ctrl+1) or
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2. Create aNew file called Lathe Tutorial.

3. Select a Horizontal Lathe from theMachine list.

4. Select the inchmeasurement type.

5. Input the values shown.

The stock size will be used to draw the workspace outline and origin marker. The workspace is
drawn round. The Clearance options and Tool Change positioning are not important now and are
described in the Lathemanual.

6. Select the Diameter option for the X Dimension style.

Enter a Comment. (Remember this should help describe the part.)

7. Close the Documents dialog.

In this example, we will begin on the face of the thread, and work counter-clockwise. Turning
parts are symmetrical about the X axis. Therefore, we will only need to draw the top cutaway
profile of the part.

Creating Geometry

This tutorial will take you through creating geometry for a Lathe Part using theGibbsCAM
Geometry Palette.
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1. Open theGeometry Creation palette.

2. Open the Point sub-palette.

3. Select Explicit point .

Input the values shown.

4. Click the Single Point
button.

This will be our start and end point. It is created for reference only. (If your view is different, try
clicking View>Home.)

Face

1. Open the Line sub-palette.

2. Select Axis line.

3. Select the vertical
linemode.

Input the value
shown. (Z = 0).

4. Click theMultiple Lines button.
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OD

1. Switch to the
horizontal line
mode.

Input the value
shown. ( Xd =
2.25).

2. Click the Single Line button. The horizontal line is
drawn.

3. Select the two lines shown.

4. Choose View Labels.

All geometry will now be defined by a letter indicating the type of geometry (P for point, C for
circle, L for line) and a number indicating the order of creation.

5. Shift+Drag amarquee to select the two
lines and click the Connect-Disconnect
button.

(If your view zooms to your marquee rather than selecting the lines, ensure that you are not in a
sub-menu of the geometry palette.)



Exercise 3: Lathe Tutorial

47

The point (P2) is created as a connector
point.

6. Turn off Labels.

7. Open the Line sub-palette.

8. Select Point Angle line.

9. Click the P button

This area allows you to create a descriptor point which the angled line intersects.

10. Input the values shown. (A= 45, Xd = -
0.975, Xd = 2.25)

11. Click the Single Line button.

Using the Connect-Disconnect button, we will connect the two lines at the point where they
intersect.

12. Connect the two lines shown.
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The line will trim because it has two
connector points.

13. Open the Line sub-palette.

14. Select Axis line.

15. Select the horizontal linemode.

16. Input the value shown. (Xd = 1.6).

17. Click the Single Line button.

18. Open the Line sub-palette.

19. Select Point Angle line.
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20. Click the P button
Input the values
shown. (A = -63, (Z =
-2.2, Xd = 2.8).

Angle values follow the standard Cartesian coordinate system, as shown. Negative
values are acceptable as input.

21. Click the Single Line button.

22. Connect the two lines shown.
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23. Connect the next two lines shown.

24. Your screen should now look like this

25. Open the Line sub-palette.

26. Select Axis line.

27. Select the horizontal linemode.

28. Input the value shown. ( Xd = 2.8).

29. Click the Single Line button.
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30. Connect the two lines shown.

Your screen should now look like this

31. Open the Line sub-palette.

32. Select Point Angle line.

33. Click the P button and input
the values shown. (A = -114, Z = -
2.5, Xd = 2.8).

34. Click the Single Line button
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35. Connect the two lines shown.

Your screen should now look like this

36. Open the Line sub-palette.

37. Select Axis line.

38. Select the horizontal linemode.

39. Input the value shown. (Xd = 1).
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40. Click the Single Line button.

41. Open the Line sub-palette.

42. Select Point Angle line.

43. Click the P button and input the
values shown. (A = -66, Z = -3.8, Xd
= 2.8).

44. Click the Single Line button.

45. Open the Circle sub-palette.

46. Select the lines shown.

Remember the Ctrl key is not needed
because a sub-palette is open.
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47. Input the radius value shown. (R = .2).

48. Click theMultiple Circles button. The four circle tangencies between
the two lines selected will be
displayed.

49. Select the upper left circle. Click theOK
button.

50. Select the lines shown. The radius should
still be defined as 0.2; therefore, no editing
is necessary. 

51. Click the Single Circle button.

52. Select the upper right circle as shown.

Click theOK button.
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53. Select the line shown below and choose

Modify Duplicate.

54. Connect the lines shown.

Your screen should now look like
this

55. Open the Line sub-palette.

56. Select Point Angle line.

57. Click the P button and input the
values shown. (A = 85, Z = -4 Xd = 2.8).
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58. Click theMultiple Lines button.

59. Change to the values shown. (A = 95
Z = -4.15, Xd = 2.8).

60. Click the Single Line button.

Your screen should now look
like this

61. Open the Line sub-palette.

62. Select Axis line, then select horizontal linemode.

63. Input the value shown. (Xd = 2.52).

64. Click the Single Line button.
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65. Connect the lines shown.

66. Next connect these lines.

67. Select the lines as shown, then
connect them.

68. Select the line shown below

and chooseModify
Duplicate.

( + )
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69. Connect the two lines as shown.

Backface

1. Open the Line sub-palette.

2. Select Axis line.

3. Select the vertical linemode.

4. Input the value shown. (Z = -4.9).

5. Click the Single Line button.
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6. Connect the lines shown.

Your screen should now look like
this

7. Open the Line sub-palette.

8. Select Axis line.

9. Select the horizontal linemode.

10. Input the value shown. (Xd = .8).

11. Click the Single Line button.
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12. Connect the lines shown.

Your screen should now look like
this

ID

1. Open the Line sub-palette.

2. Select Point Angle line.

3. Click the P button and input the
values shown. (A = 45, Z = -2.6, Xd =
0.8).

4. Click the Single Line button
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5. Connect the lines shown.

6. Open the Line sub-palette.

7. Select Axis line.

8. Input the value shown. ( Xd = 1.4).

9. Click the Single Line button.

10. Connect the lines shown.



Exercise 3: Lathe Tutorial

62

11. Select the line shown below

and chooseModify
Duplicate.

+

12. Open the Point sub-palette.

13. Select Explicit point.

14. Input the values shown (Z = -1.1, Xd =
1.4).

15. Click the Single Point button.

16. Select the point and line shown.

17. Open the Circle sub-palette.
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18. Input the value shown. (R = 0.2).

19. Click the Single Circle button.

20. Click theOK button.

The circle selected will be drawn and a connector point will be created between the circle and
the line. When tangent features are created theywill create connector points when possible.

Explicit Connect

Connect the circle, point and line
shown.

When using a point and two features tomake connections themultiple features dialog is
bypassed because the point is specifying the connection position. This is usually the case when
connecting non-tangent circles with other features.
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Closing the Shape

Connect the lines shown.

Notice the point has now been replaced by a connector even though we didn’t select it.

Adding Fillets
Now wewill create the fillets and chamfer specified on the print.

1. Ctrl+click the 4 points shown.

2. Open the Fillet-Chamfer sub-palette.

3. Select the Fillet mode.

4. Input the value shown. (R = 0.2).
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5. Click the Single Circle button.

6. Ctrl+click the 2 points shown.

7. Open the Fillet-Chamfer sub-palette. (The Fillet mode should still be active.)

8. Input the value shown. (Radius =
0.015).

9. Click the Single Circle button.

Adding a Chamfer

1. Select the point shown.

2. Click the Chamfer-Side button.
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3. Input the side value shown (Side =
.2).

4. Click the Single Line button.

The geometry for this part is now complete.

Save this part.

Wewill machine this part in the Lathemanual.

Exercise 4: Shuttle
OD

1. Create the horizontal lathe part
shown.

2. Select the Radius and Inch options.

3. Open theGeometry palette.

4. Open the Circle sub-palette.
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5. Select Radius & Center Point circle.

6. Click the CP button and input the
values shown. (R = 1, Z = -1, Xr = 0).

7. Click the Single Circle button.

8. Open the Line sub-palette.

9. Select Axis line.

10. Select the horizontal linemode.

11. Input the value shown (Xr = 0.875)
and press Enter.

12. Connect the circle and line
shown.

The two possible points of intersection between the selected line and circle will be drawn, and
the dialog shownwill come up on the screen asking you to select the desired features.
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13. Select the right point as shown and
click theOK button.

14. Open the Line sub-palette.

15. Select Axis line.

16. Select the vertical linemode.

17. Input the value shown. (Z = -1).

18. Click the Single Line button.

19. Connect the lines shown.

20. Open the Point sub-palette.

21. Select Explicit point.
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22. Input the coordinate values shown. (Z
= -1, Xr = 0.938).

23. Click the Single Point button.

24. Zoom in on the area shown.

Because some of the points are very
close together, we will zoom in on the
area tomake the necessary geometry
selectionsmuch easier.

25. Open the Circle sub-palette.

26. Select Radius & Center Point circle.

27. Click the CP button and input the
values shown. (R = 0.5, Z = -1.621
Xr = 1.5).

28. Click the Single Circle button.

29. Open the Line sub-palette.
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30. Select the circle and point shown.

31. Click the Single Line button.

32. Select the bottom line shown.

33. Click theOK button or press

The point created between the line and the circle is a connector point. However, the point that
was used to create the line remains a plain yellow point. Wewill need tomanually connect that
point.

34. Connect the lines shown.

35. Open the View palette and click the No Zoom
button.

This will fit the workspace stock in the window.

36. Open the Line sub-palette.
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37. Select Angle & Tangent Circle line.

38. Select the circle shown.

39. Input the angle value shown. (A =
140).

40. Click the Single Line button.

41. Select the line shown and
press

42. Open the Line sub-palette.

43. Select Axis line.
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44. Select the horizontal linemode
and enter the value shown. (Xr =
1.651).

45. Click the Single Line button.

46. Open the Point sub-palette.

47. Select the two lines as shown.

48. Click the Single Point button.

The point created is a connector point and the angled line is trimmed.

49. Select the horizontal line and click the Trash button.

The point will change to a plain point and the
angled line will change to yellow and become
untrimmed.

50. Open the Line sub-palette.

51. Select Point Angle line.
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52. Click the P button and input the
values shown. (A = 135, Z = -3 Xr =
2).

53. Click the Single Line button.

54. Zoom in to the area in the upper
left corner as shown.

55. Open the Circle sub-palette.

56. Select the point and line shown.
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57. Input the radius value shown.

58. Click the Single Circle button.

59. Select the upper left circle as
shown.

60. Click theOK button. or Press the key.

One of the points created is a connector point. Wewill need tomanually connect the other plain
point.

61. Connect the point, line, and
circle shown.

The point will become a connector point, and the line and circle should trim, and become blue.
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62. Choose View > Unzoom

63. Open the Line sub-palette.

64. Select Axis line.

65. Select the vertical
linemode

and enter the value
shown. (Z = -3).

66. Click the Single Line button.
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67. Connect the lines shown.

68. Open the Line sub-palette.

69. Select Axis line.

70. Select the
horizontal line
mode

and enter the
value shown. ( Xr
= 0).

71. Click the Single Line button.

72. Connect the lines shown.

73. Connect the lines shown.

74. Select the right point and press

The geometry for the part is now complete and fully connected.
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Exercise 5: Text Creation

In this example wewill create text geometry. Wewill use the same text to show the different
methods of alignment, spacing. and text flow.

Horizontal Text

Left Justified

1. Before starting the tutorial, youmay need to adjust your view area to see the whole part
(Home>Unzoom.)

2. Create a new 3 Axis Vertical Mill part with the following stock specifications:+X = 5, -X = -5, +Y
= 4, -Y = -4, Z = 0, -Z = -1. Leave all other items at their default settings. 

3. Open theGeometry palette.

4. Open the Shape sub-palette.

5. Open the Text Creation dialog.
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6. Input the values shown into the
Text Creation dialog.

The font list contains all the available TrueType fonts.Moorpark is an installed TrueType font
specifically designed for centerline engraving. If you havemany fonts in the list, type the first
letter of the name of the font to navigate to it faster.

7. Click the Do It button.

We have added lines at X-
0.75 and Y-2.0 to show
how the text aligns.

8. Choose View and ensure that under the visibility submenu, the points icon is unchecked
(white background). This will make the text easier to read.

The lines on the screen illustrate the text alignment according to the align point and the position
selected on the Alignment Diagram. The text starts in the upper left corner of the rectangular
text area.

Centered

1. Create a newWorkgroup

2. Click theWorkgroup button , click
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New WG. The eye icon in the
Workgroupmenu indicateswhich
Workgroup is visible.

After creating the newWorkgroup,
ensure that onlyWorkgroup 2 is visible.

3. Open the Text Creation dialog.

4. Enter this information in the
Spacing tab.

(The text you typed previously still
remains.)

The values entered for spacing are added to the default spacing.

5. Enter this information in the Text
tab.

6. Click the Do It button.
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Again, we have added
lines at X = -0.75 and Y = -
2 to visualize the text
alignment.

Vertical Text

1. Create a newWorkgroup 3.

2. InWG:3 open the Text Creation dialog.

3. Enter this information in the Text
Flow tab.

4. Enter this information in the
Spacingtab.

(The text input previously
remains.)
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5. Enter this information in the
Texttab.

6. ClickDo It.

The text is aligned in the upper right corner of the text area as specified by the alignment dialog.
We have added a line at X=-2.75 and Y=3.5 to show the alignment.

Text On An Arc

1. Create aWG4 and switch to it.

2. Enter this information in the Text
Flow tab.

3. Enter this information in the
Spacing tab.
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4. Enter this information in the Text
tab.

(The text input previously
remains.)

Note that the alignment diagram is different. The Radius specifies the size of the arc and the
Angle indicates the position on the arc that the text will begin. Also, a center point for the arc
must be entered (rather than an alignment point).

5. Create the text.

In order to show the alignment we have added a circle with centre point and radius as specified
with the Angle, Radius and Center Pt. values entered in the dialog. The text is positioned along the
outside of the arc and is positioned along the center of the y axis line as specified by the angle.
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Exercise 6: Gear Creation
Creating a Gear

In this exercise wewill create an involute spur gear. Wewill walk through the steps. The gear has
the following knownmetric dimensions.

Outside Diameter: 11.666mm 

Pitch diameter: 10mm

Inside Diameter: 7.916mm

Pressure Angle: 25°

Number of Teeth: 12

Typically, the Pitch Diameter and theNumber of Teeth are known values.Wewill use these values to
obtain the value for the Diametral Pitch.

Diametral Pitch = # Teeth ÷ Pitch Diameter

(Diametral Pitch: 12 ÷ 10 = 1.2)

1. Create a new 3 Axis Vertical Mill part with the following stock specifications:+X = 6, -X = -6, +Y
= 6, -Y = -6, Z = 0, -Z = -1.

2. Open the Shape sub-palette.

3. Open theGear dialog.

4. Set the Pressure Angle to 25°.  Set theOrientation to External and the Gear Type
to Gear.

5. Input the Diametral Pitch value, Full # Teeth
amount.

The other Pitch settings are automatically calculated.

6. Input the Involute Curve settings as shown.
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7. Click the Calculate
button.

The formulas for calculating the Addendum andDedendum are as follows:

Addendum = (Major Diameter – Pitch Diameter) ÷ 2

Dedendum = (Pitch Diameter – Minor Diameter) ÷ 2

8. ClickDo It to generate the shape of a single
tooth.

Do not deselect the tooth geometry - it is
drawn in red as shown below.

9. From theModifymenu select Dup + 2D
Rotate.

The 2D rotate calculates the number of times to repeat the geometry to create the complete
gear. Additionally, when you create the duplicated geometry it is automatically connected.
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10. Click the Do It button.

Your screen will now look like this:

Exercise 7: Overlapping Features

A good understanding of connections and connector points is necessary to become proficient.
While connecting a shape is a simple process, this exercise details how to create a connected
shape when individual features overlap one another.
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Overlapping Connections

Circles

This exercise providesminimal direction on how to build the part. Be sure to check your
progress carefully against the illustrations at each step. The part is a simple shape. It consists of
six circles, and no lines.

1. Create a 3 Axis Vertical Mill Vertical Mill part with the following stock specifications: +X = 3, -X
= -3, +Y = 3, -Y = -3, Z = 0, -Z = -1. Dimensions should be in inch.

2. Create P1 (point 1) at
X0Y0.

Use the Bolt Circle button
(in the point sub-menu) to
create the other three
points on a two-inch
radius.
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3. Create three 0.5" circles around P2,
P3, and P4.

4. Create one 2.0" circle around P1.

There are now twoways to proceed:

For the sake of completeness, we will first show you the longmethod, where you add features and
connections one by one.

Then, we will show the short method where you can combinemultiple shapes in one step.

Sequentially Add Features and Connections

C4 is one of three 2.0" circles needed. Putting twomore circles on top of C4makes it difficult to
tell which one you are clicking on. The best approach for all shapes is to work around the shape
in a specific direction (clockwise or counter-clockwise), adding features and connections as you
go. In this example, you can use C4 as any one of the three circle segments (or arcs). The key
idea is to fully connect C4 before adding another 2.0 circle to the workgroup. Starting with C1,
we’ll proceed clockwise around the shape.

Let’s connect C4 between C1 and C2. Select C1 and C4 circles and use the Point button or the
Connect/Disconnect button (or press the number 8) to find the intersections between C4 and
C1.
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1. Select the point shown.

P5 is drawn at the selected intersection of C1 and C4.

2. Now connect C4 to C2. Use the
Point button again.

3. Connect C4 to C2 by selecting the
point shown.
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P6 is drawn at the selected
intersection of C2 and C4,
completing the connection for this
feature.

4. Add the next 2.0" circle around P1
or duplicate C4.

C5 now overlaps the arc C4. Selecting C5where it overlapsC4will only select C4. The system
will always select the lowest-numbered circle in the overlapping area. The selection order of
geometry that overlap are as follows: points, lines, then circles. If you click C5where it does not
overlap C4, C5 will be selected and highlighted as a full circle.

5. Connect C5 to C2 using the point
shown.
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P7 is drawn at the selected intersection of C2 and C5. It is the second connection for C2,

therefore completing this feature. Use Reverse Arc (Ctrl+T) if necessary.

6. Now connect C5 to C3 using the point
shown.

P8 is drawn at the selected
intersection of C3 and C5.

7. Create the last 2" circle around P1.
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8. Connect C6 to C3 using the point shown.

P9 is drawn at the selected
intersection of C6 and C3.

9. Connect C6 to C1.

10. Connect C6 to C1 using the point shown.



Exercise 7: Overlapping Features

92

P10 is drawn at the selected
intersection of C6 and C1, creating
fully-connected geometry. The shape

is now complete. Choose View
Labels for a clearer view.

Short method (optional): Combine Multiple Shapes.

If you are comfortable with the concepts of connecting and disconnecting, you can optionally use a
different method that can bemuch quicker.

1. Undo steps 5 through 14 (for example, press Ctrl+Z about 12 times), until you have restored
the four unmodified circles. 

2. Select a circle, and then
Ctrl+select each of the other three
circles.
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3. In the Shape sub-palette, select

Combine Shapes and then

select the Shape Union button
.

Remember that the directions andmethods used in the system to create a shape have no effect
on how the shape ismachined. The cut can begin anywhere, stop anywhere, and cut in any
direction. The tool can cut outside, inside, or on the shape. This will be covered inmore detail in
the Lathe andMill manuals.
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GEOMETRY EXPERT EXERCISES

The exercises contained in this chapter are designed to introduce you to the basic concepts of
geometry creation using Geometry Expert. For part dimensions for each of these exercises, see
“Part Prints” on page 158 . Lathe examples can be completed with Mill, and vice-versa.

Exercise 1: Shaft

Horizontal and Vertical Lines

In the first exercise, we will create a simple shaft containing only horizontal and vertical lines.
Because of the feature type defaults and automatic angle toggling, the creation of a simple shaft
can be done very quickly with Geometry Expert. For the part print for this exercise, see “Shaft” on
page 163. 

1. Open the Documents dialog.

2. Create a Horizontal Lathe - Generic
shankMDD part with the following
dimensions.

3. Select inch and Diameter for the dimension style.

4. Rotate your view to display the work area (Home - Un-Zoom)

5. Open theGeometry palette.

6. Open theGeometry Expert.

The first row (current row) is highlighted in black because the row needsmore information in
order to define the feature.

Notice that whenGeometry Expert opens, the feature type selected is a line, and the angle
value is 90°.

The feature wewill start with is the vertical line at Z0.

7. Input the values shown.
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When defining either horizontal or vertical lines, it is only necessary to enter a half point (a value
for one axis) for the line point.

When only one coordinate value is entered, it is referred to as a half
point. In certain cases only a horizontal (H) or vertical (V) coordinate
value is needed in order to define the feature.

Once enough data to create a feature is entered the row is highlighted in yellow.

8. Press Enter.

We have switched labels on
(View>Labels checked) so
you can see what happens.

This will create the line and a new row, highlighting themost logical cell to enter data for the
feature type selected.

The second row is a line feature type and the angle is switched automatically to a horizontal line.
(We have switched labels on (View>Labels checked) so you can see what happens.)

9. Input the values shown.

Since the purpose of Geometry Expert
is to create a single shape, connections
are assumed. Therefore, when
features do not have a point of
connection an error message will be
displayed.

10. Input the values shown.
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Notice that the line
angle has again
switched to a vertical
angle.

11. Input the values shown and press
Enter.

At this stage the display
becomes a little crowded so
Labels have been switched off.

12. Input the values shown and press
Enter.

Once a feature has been
drawn on the screen, a
reference number is
assigned and entered in
the Ref column.

13. Input the values shown and
press Enter.
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14. Input the values shown and press Enter.

15. Input the values shown and press
Enter.

16. Input the values shown and press
Enter.
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17. Input the values shown and press
Enter.

18. Input the values shown and press
Enter.

19. Input the values shown and press
Enter.
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20. Input the values shown and press
Enter.

21. Input the values shown and press
Enter.

22. Input the values shown and press
Enter.
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23. Input the values shown and press
Enter.

24. Input the values shown and press
Enter.

25. Input the values shown and press
Enter.
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26. Input the values shown and press
Enter.

27. Input the values shown and press
Enter.

28. Select the Close Shape feature
type (Alt+6 or click the line
icon in the far left column of the
geometry expert dialog to
display themenu below.)

The Close feature type connects the first and last feature at their point of intersection.
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The shaft is complete
and fully connected

Save this part.

Exercise 2: Chassis

In this exercise, we will introduce adding different feature types such as fillets and chamfers. Refer
to Part Print #2: Chassis for this exercise.

Chamfers and Fillets

1. Open the Documents dialog.

2. Create a 3 Axis Vertical Mill part
with the following workspace
stock dimensions.

3. Select inch for themeasurement type.

4. Open theGeometry palette.
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5. Open theGeometry Expert.

6. Input the value shown and press
Enter.

7. Change the view to Home,
no zoom.

8. Change the feature type to a Fillet (3rd button) as
shown.

The feature type can be selected using keyboard shortcuts. For example pressing Alt+3 is the
same as selecting Fillet feature type.

9. Input the value shown.

Only a radius value is required when creating fillets. Notice the prompt. “This row will create a Fillet
between the preceding and following features.” Fillets and chamfers are entered between the two
features they connect with. Fillets and chamfers can only be created between two intersecting
features at their point of intersection.

10. Press the Enter key.

Since there isn’t enough information to define the complete Fillet nothing is drawn.When the
next feature is completely connected and trimmed the Fillet will become complete and be
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created. Fillets, Chamfers and tangent features are completely dependent on the features that
they exist between and can only be seen once the features they are created from are completely
defined.

11. Input the 2 values shown and
press Enter.

12. The two lines drawn are
connected.

13. Change the feature type to a Chamfer (Alt+2).

Input the value shown.

Chamfers created in Geometry Expert are dimensioned according to the Side length. To create
chamfers that are dimensioned differently, use the Chamfer palette in the free-formCAD tools.

14. Press the Enter key.
Again, the chamfer will be drawnwhen the
features it exists between are fully
connected.

15. Input the value shown and press
Enter.
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Your screen will look like
this

16. Select the
Fillet feature
type (Alt+3).

The radius value for the fillet will default to the previous radius entered for a fillet. Therefore, you
don’t need to enter a radius value.

17. Press the Enter key.

18. Input the value shown and press
Enter.
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The chamfer is now
drawn because the
preceding and following
lines are fully connected.

19. Select the Fillet
feature type
(Alt+2) and
press Enter.

20. Input the value shown and press
Enter.

The fillet is now drawn
because the preceding
and following features
now have two connector
points.
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21. Select the
Chamfer
feature type
(Alt+2) and
press Enter.

The length value for the chamfer also defaults to the previous value entered.

22. Input the value shown and press
Enter.

While we could continue
making fillets and
chamfers in thismanner,
from this point on, we will
only create the horizontal
and vertical lines. Then,
we will use the free-form
CAD tools to create the
remaining fillets and
chamfers.

23. Input the value shown and press
Enter.
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24. Input the value shown and press
Enter.

25. Input the value shown and press
Enter.
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26. Input the value shown and press
Enter.

27. Input the value shown and press
Enter.
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28. Input the value shown and press
Enter.

29. Input the value shown and press
Enter.
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30. Input the value shown and press
Enter.

31. Input the value shown and press
Enter.



Geometry Expert Exercises

112

32. Input the value shown and press
Enter.

33. Input the value shown and press
Enter.
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34. Input the value shown and press
Enter.

35. Input the value shown and press
Enter.
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36. Input the value shown and press
Enter.

37. Input the value shown and press
Enter.
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38. Input the value shown and press
Enter.

39. Input the value shown and press
Enter.
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40. Input the value shown and press
Enter.

41. Input the value shown and press
Enter.
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42. Input the value shown and press
Enter.

43. Input the value shown and press
Enter.
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44. Input the value shown and press
Enter.

45. Select the Close Shape feature type for the last row.

46. CloseGeometry Expert.
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47. Ctrl+click the outside
corners as shown.

If you accidentally click something that you didn’t want to and it becomes selected, click it again
to deselect it.

48. Open the Fillet/Chamfer sub-palette.

49. Select the Fillet mode.

50. Input the value shown and press
Enter.

Fillets are created at all of the selected corners.
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51. Ctrl+click the inside
corners as shown.

52. Open the Fillet/Chamfer sub-palette.

53. Select the Chamfer - Sidemode.

This is themode that Geometry Expert useswhen creating chamfers.

54. Input the value shown and press
Enter.
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55. Click the Single Line button

The Chassis is now complete.

Save the file.

Exercise 3: Shuttle

In this exercise, we will create a slightlymore complex shape containing arcs and angled lines. This
exercise will also introduce how the Select Feature dialog works. For the part print for this exercise,
see “Shuttle” on page 161.

Arcs and Angled Lines

1. Create a horizontal lathe part with
the following workspace stock
dimensions.

2. Select the Radius option for the X dimension style.1

Mill Users
If you want to create this as aMill part, input the stock values shown. The images shown in
Geometry Expert will be slightly different. In Lathe, the horizontal values shown are entered as Z
coordinates, and the vertical values are entered as Xr coordinates. If you are working inMill, the
horizontal values are entered as X coordinates, and the vertical values are entered as Y
coordinates.

1. Open theGeometry Expert.

2. Select Counter-Clockwise Arc or press Alt+5 for the first feature.

Remember, the feature type can also be selected using keyboard shortcuts [Alt+(1-7)].
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3. Input the values shown and press
Enter.

4. Input the values shown and press
Enter.

There are two possible points of intersection between the line and the circle. When this is the
case, the Select Feature dialog will appear.

5. Select the right point shown
and click theOK button.

You can now continue creating connected features in Geometry Expert.

6. Input the values shown
and press Enter.

7. Delete the angle value and
press Enter.

Notice the prompt. Although this row contains no data other than the feature type, following
featureswill provide the systemwith the required information to define and draw this line. It will
not be created until all necessary information has been entered. This is an example of a floating
feature.

The next row’s feature type will default to a clockwise arc.

8. Input the values shown and
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press Enter.

The previous line and the arc are drawn.

9. Input the values shown and
press Enter.

A half end point is valid in this case. As the prompt indicates, the systemwill calculate the other
endpoint coordinate with the information it has, and draw the endpoint on the screen. An
endpoint is necessary on this line because the following arc is not tangent to this line. The end
point of the preceding feature will be used as the start point of the circle. Note that it is important
the angle value entered indicate the proper vector direction of the line because the next feature
is an arc.

10. Select Clockwise Arc feature type (Alt+4).

11. Input the values shown and
press Enter.

This is another example of a floating feature, this time a circle. The circle will be drawn once we
define the next feature. The system uses the information from the previous row (in this case the
endpoint) and the information from the following row (which will provide a tangency point) to
draw the arc.

12. Input the values shown and press
Enter.
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(If the line is truncatedmake sure
View>Extend linesoption is checked.)

13. Input the values shown and press
Enter.

14. Input the values shown and press
Enter.

15. Select the Close Shape feature type (Alt+6).

There are two possible intersection points, so the systemwill ask you to select which
intersection point should be used. There is an option in the Editmenuwhich allows you to
change the intersection point chosen in the select features dialog once the connection has been
made. This Editmenu item toggles between Use Intersection #1 and Use Intersection #2.

16. Select the right point shown and
press Enter.



Geometry Expert Exercises

125

17. Resize Geometry Expert so all
rows are visible.

18. Select the cell shown.

Notice that the row becomes highlighted and is now the current row. Also, the arc that is defined
by this row is now selected.

19. Change the radius value to 0.4 and
press Enter.

The radius is adjusted andmaintains the connections.

Exercise 4: Lathe Tutorial

Make sure that you save this file in a place where you can easily access it, because it will be used in
themachining tutorial found in the Lathemanual. This part is also created in the Free-FormCAD
Exercises.

Lathe Tutorial

1. Create a lathe part with
dimensions set as inchwith the
following workspace stock
dimensions.

2. Choose Diameter for the X Dimension Style.
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3. Open theGeometry Expert.

4. Input the value shown and press
Enter.

5. Select the Chamfer feature type (Alt+2).

6. Input the value shown and press
Enter.

This chamfer will be drawnwhenwe close the shape.

7. Input the value shown and press
Enter.

8. Input the values shown and press Enter.

If the line
does not
draw
properly
make sure
View>Exte
nd lines is
checked)

9. Select the Fillet feature type (Alt+3).
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10. Input the values shown and press Enter.

This Fillet will be drawnwhen the next feature is defined.

11. Input the values shown and press Enter.

12. Select the Fillet feature type (Alt+3) and
press Enter.

The radius defaults to the last entered value.

13. Input the values shown and press Enter.

14. Input the values shown and press Enter.

Both fillets are created
because the preceding and
following features are fully
connected.

15. Input the values shown and press Enter.
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16. Select the Fillet feature type (Alt+3) and
press Enter.

17. Enter the angle and line point value shown
and press Enter.

18. Select the Fillet feature type (Alt+3) and
press Enter.

19. Input the values shown and press Enter.

20. Input the values shown and press Enter.

21. Input the values shown and press Enter.
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22. Select the Fillet feature type (Alt+3) enter
the radius value shown and press Enter.

23. Input the values shown and press Enter.

24. Select the Fillet feature type (Alt+3) press
Enter to accept the default value shown.

25. Input the values shown and press Enter.

26. Input the values shown and press Enter.

27. Input the values shown and press Enter.
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28. Input the values shown and press Enter.

29. Select the Fillet feature type (Alt+3)

30. Change the radius and press Enter.

31. Input the values shown and press Enter.

32. Select the Fillet feature type (Alt+3) and
press Enter.

33. The radius defaults to the last entered value.

34. Input the values shown and press Enter.
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This linemust be defined with an
endpoint because the next feature is
an arc that is not tangent. Whenever
an arc is not tangent to the previous
line, the arc needs to have a start
point.

35. Select the Clockwise Arc feature type (Alt+4).

36. Input the values shown and press Enter.

Notice the prompt.

Implicit Angle Tangent Line

37. Input the values shown and press Enter.

An angle value of 0° must be entered for this line because it is connected to an arc, and wemust
indicate the exact direction of the line. Line direction is determined by the angle value. Since we
defined this part in the CCW direction of the shape, this line is 0. We could have defined the part
in the clockwise direction, and the angle value would have been 180°.

38. Selecting the Close Shape feature type
(Alt+6).

Notice that the chamfer we created at the beginning has been drawn because the lines it is
between are now fully connected.
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Save this part.

Exercise 5: Doodle

In this exercise, we will show how theGeometry Expert can aid in fixing a rough sketch of the part
geometry using themouse line tool. For the part print for this exercise, see “Doodle” on page 165.

Editing Free-Form Geometry

Again this part can be done with either theMill or Lathe workspace stock definition.

1. Create a lathe part with inch
dimension and with the following
workspace stock dimensions.

2. Select Diameter for the X dimension style.

3. Open theGeometry palette.

4. Open the Line sub-palette. (2)

5. Select Mouse line.

Wewill start sketching the part from the vertical line at Z -6.25. Don’t worry toomuch about the
coordinates shown in theMouse Line dialog, the dimensionswill be adjusted using Geometry
Expert.

DONOT draw the chamfer on the part. Wewill insert that in the spreadsheet.
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6. Click near the location of point
1.

7. Continue creating the part
following the part print until
the shape is closed (when
you click on the first point
again).

Your finished part should
look something like this:

This is a very quick process because we aren’t concerned with proper dimensions.We only
need an approximate shape or have the same number of features (excluding the chamfer).

8. Open theGeometry Expert.

Loading Free-Form Geometry

1. Double-click the first line
we created as shown.

All connected featureswill be loaded into the Geometry Expert spreadsheet with the dimension
values. The first feature listed in the spreadsheet will be the feature that you clicked on to load
the shape. All the other featureswill be listed in creation order from that first feature.
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2. Scroll to the top of the
Geometry Expert using the up
arrow on the slider bar as
shown below.

If you selected the line as shown above, the first feature should be a line with an angle close to
90° around Z -6.25. If your reference numbers don’t exactlymatch those shown in the pictures,
don’t worry about it.

Click in one of the cells in the first row.

3. Change the values as shown
and press Enter.

The row can also be reached using the arrow keys or themouse.When you have changed the
values you will find that the Enter keywon’t scroll to the next row.

The feature is highlighted in red and will change according to the new dimensions. Tomove
down to the next row in the spreadsheet youmust use the arrow keys or click the cursor within a
cell of another row. Be careful to use Backspace to delete any values, as the Del keywill delete
the entire row.

4. Change the second feature as
shown and press Enter.

Continue to adjust the part dimensions in thismanner. You can select the geometry or the row
and edit the values tomatch the part print. Be careful to use Backspace to delete, as the Del
keywill delete the entire row.

Because of the existing connections and locations of points, when youmake some of the
adjustments it may look like something is wrong; the features and overall shapemay not look the
way it should. Don’t worry, keep going through and changing the dimensions, andGeometry
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Expert will adjust the shape correctly. Youmay find that editing down each vertical line is faster.
If somehow theGeometry Expert fails in someway, youmay have to fix the geometry with the
mouse line and connect button. Geometry Expert will not be able to regenerate some broken
connections.

When finished, the Geometry Expert should appear as shown. Notice that the close shape row
is already in the spreadsheet. It was entered in the spreadsheet when we double clicked and
loaded the shape because it was a closed shape.

Your part should now have accurate dimensions.

Inserting a Row

1. Select the line at Z = 0.
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2. Choose Edit> Insert row
(Alt+I).

A row with no information other than the feature type, which is a line, will be inserted in the
spreadsheet above the current row. Notice the new row is now the current row.

3. Select the Chamfer feature type (Alt+2).

4. Input the value shown in the
inserted row and press Enter.

The chamfer will immediately be drawn because it is being created at the intersection of two
features that have already been connected.

Try sketching any shape and adjusting the dimensions. If any problems occur, the Error
Balloons, and Prompting information should indicate what needs to be done. You can also
combine Free-Form tools with the Geometry Expert, which wewill cover in the next section.
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COMBINATION EXERCISES

The exercises contained in this chapter use both Geometry Expert and the free-formCAD tools to
create part geometry. In the first exercise, we will demonstrate how to change shapes created in
Free-formGeometry. In the second exercise, we will re-create theMill Tutorial part using primarily
Geometry Expert, but we will need to use the free-formCAD tools to create some construction
geometry. For amore advanced example of construction see “Exercise 3: Gear Housing” on
page 154. This can be done once you feel comfortable with both Geometry Expert and free-form
CAD.

Exercise 1: Using Geometry Expert to Modify
Shapes

In Part A of this exercise, we will load theMill Tutorial part. For the part print see “ Mill Tutorial” on
page 159.

Mill Tutorial

Changing the Shape

1. Open theMill tutorial part.

A part file can be opened in several ways. Themost simplemethod is using theOpen
command in the Filemenu or in the Documents dialog. More advancedmethods
include the shortcut Ctrl+O or drag and dropping files. A file can be dropped in a
running version of GibbsCAMor on an icon (including a shortcut icon). See the
Getting Startedmanual for more information on the basics of using the system.

2. Choose File > Save As... Save the file with a new name.

3. Open theGeometry Expert.

4. Double-click the large arc
shown.
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The exterior shape
is loaded into the
Geometry Expert.
Note the features of
the boss are not
loaded because the
bosswas not part
of the shape
selected.

5. Select the first row, the 2" circle.

6. Change the radius and press
Enter.

The features connected to the arc have changed. The features tangent to the arc have adjusted
accordingly.

7. Select the line as shown.
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8. Change the angle value as shown
and press Enter.

The feature changes according to the new dimension entered.

Both of the changeswe havemade here havemaintained the continuity of the shape without
breaking it into individual geometry. Shapes are broken when features do not have any points of
intersection or tangency. Geometry Expert will display an error message to indicate that the
feature has no intersection with the previous feature.

9. Select the arc shown.

10. Change the radius value and
press Enter.

When you attempt to enter the row, an error message will come up in the spreadsheet indicating
that the previous feature cannot intersect.
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The circle will be re-drawnwith the
new radius in yellow, indicating that it
is not a fully connected feature.

11. Undo the change (Ctrl+Z).

The shape will re-connect.

Lathe Tutorial

Changing the Shape

Open the Lathe tutorial part.

Before changes aremade to the part, we will make a copy of the file. Because we are going to use
this part geometry for themachining tutorial in the Lathemanual, we need to keep a copy of the file
that will not be changed.

1. Choose File > Save As... and save the file with a new name.

2. Open theGeometry Expert.

3. Double-click the line shown.

4. Locate the row shown.

This row is a 270° line at Z -4.9.
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5. Change the Z value as shown
and press Enter.

The geometry will change according to the new dimensions entered. The features connected
to that line are also changed tomaintain the proper connections.

6. Select the arc shown.

This row now becomes the selected row. Inversely, selecting the row would highlight the
feature being defined on the screen.

7. Change the radius value as
shown and press Enter.

Again, the shape will change according to the new dimensions entered.

Both of the changeswe havemade havemaintained the continuity of the shape.

8. Select the arc shown.

9. Change the radius value as
shown and press Enter.

When you attempt to enter the row, an error message appears indicating that the previous
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feature cannot intersect.

The arc will be re-drawnwith the
new radius value even though it
cannot connect. Notice that it is
now yellow, indicating that it is not
a connected feature.

10. Undo the change (Ctrl+Z).

The shape will re-connect.

Exercise 2: Mill Tutorial
Mill Tutorial

For the part print for this exercises, see “ Mill Tutorial” on page 159.

1. Create a new vertical mill part
with the following workspace
stock dimensions.

2. Open theGeometry Expert.
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In this exercise it is important that the direction of the lines and the circles that we create follow
the path of the shape correctly. Wewill start with the 0.5 radius circle in the upper right corner
and proceed around the part in a counter-clockwise direction. Make sure that you pay close
attention to the feature type selectionsmade and the values entered.

3. Select the Counter-Clockwise Arc feature type (Alt+5).

4. Input the values shown and press
Enter.

The only information provided
on the part print about the next
line is that it is tangent to the
circles it is connected to. (Make
sure the view is set toTop to
see the geometry correctly.)

5. Delete the angle value
(Backspace) and press Enter.

When this floating line is entered the next row will default to a clockwise arc feature type;
however, we need a counter-clockwise arc.

6. Change to the Counter-Clockwise Arc feature type (Alt+5).

7. Input the values shown and press
Enter.
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Both the circle and the line are drawn.

8. Select Clockwise Arc feature type (Alt+4).

9. Input the values shown and press
Enter.

This circle is a floating feature.

10. Select the Counter-Clockwise Arc feature type (Alt+5).

11. Input the values shown and press
Enter.

A center point must be
entered for this circle
because the preceding
feature is a floating arc, and
depends on this circle for its
creation. Therefore, this
featuremust be fully
defined.
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At this point we need to use the free-formCAD tools to create the next line because
construction geometry is required.Wewill create the geometry necessary using free-formCAD,
and then reload the shape into Geometry Expert to complete the shape.

12. CloseGeometry Expert.

13. Open the Point sub-palette. (1)

14. Select Explicit point. (1)

15. Input the values shown and press
Enter.

16. Open Circle sub-palette. (3)

17. Select Radius & Center Point. (1)

18. Select the point shown.

19. Input the value shown and press
Enter.

Extracting a Center Point of a Circle

20. Open the Point sub-palette. (1)

21. Select Center Point.

This option creates a point at the center of a selected circle.
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22. Select the circle shown and
press Enter.

23. Open the Line sub-palette. (2)

24. Select the point and circle shown, and press Enter.

25. Select the line shown and press Enter.

26. Open the Line sub-palette. (2)

27. Select Parallel line.
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28. Select the line we just created.

29. Input the value shown and press
Enter.

30. Select the line shown and press Enter.

31. Connect the circle and line shown.
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32. Double-click the circle shown. (This will select the
circle and the line that joins onto it)

33. Click the Trash button.

Now wewill load the shape
back into Geometry Expert to
create the remaining features.

34. Open theGeometry Expert.

35. Double-click any feature.

Because this shape was created using Geometry Expert, it will be reloaded in the same order as
when it was created.

The line we just created is the last feature.
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36. Create a clockwise arc
(Alt+5) with the values
shown.

37. Delete the angle and press
Enter.

This will create a tangent floating line.

38. Create a
counter-
clockwise arc
(Alt+5) with the
values shown.

39. Create a clockwise arc
(Alt+4) with the values
shown.

This will create a tangent floating arc.

40. Create a counter-clockwise
arc (Alt+5) with the values
shown.
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41. Create a line with the
values shown
connected through
the point shown.

42. Create a clockwise arc
(Alt+4) with the default value.

43. Close the shape. (Alt+6)

In order to create the center boss, we will need to closeGeometry Expert and start a new shape
because the boss is not connected to the outside wall of the shape. The bosswill also be
created using a combination of free-formCAD tools andGeometry Expert.

Boss Geometry

1. Open the Point sub-palette. (1)
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2. Select Explicit point. (1)

3. Input the coordinates shown.

4. Click the Single Point button.

5. Open the Point sub-palette. (1)

6. Select Polar Point.

7. Select the point at the origin as shown.

8. Input the values shown.

9. Click the Single Point button.

10. OpenGeometry Expert.
.
11. Select the

Clockwise Arc
feature type and
input the values
shown and press
Enter.
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12. Delete the angle of the row
and press Enter.

Wewill enter the coordinates of the centerpoint of the next arc by using the Interrogation cursor.
Clicking on a feature or point while holding down the Alt or Shift+Alt keys, the appropriate
value for the active cell will be entered in the spreadsheet. The Shift+Alt shortcut will
interrogate all the properties of a given point. The Alt key alone will interrogate the properties
for just the active cell.

13. Input the radius value shown below and then place the cursor in the CP X cell, making it the
active cell.

14. Alt+click the point
shown.

The X coordinate for that point will be entered.

15. Move to the centerpoint Y
coordinate. While holding
down the Alt key, click the
point again and press Enter.
Enter.
Alternatively you can use the Shift+Alt interrogation option. This inputs both the X and Y
coordinates in one step. You can delete the X and Y values and redo the last steps using the
Shift+Altmodifier to see how using eachmethodmay be useful.
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16. Delete the angle of the next
row and press Enter.

17. Close the shape. (Alt+6)

The geometry is now complete. Youmay use either Mill Tutorial geometry for theMill tutorial.
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Exercise 3: Gear Housing
Advanced Tutorial

About the Part

This is a rather complex part as far as geometry creation is concerned. You should only do this
exercise after you have completed the exercises in both the Geometry Expert and free-formCAD
chapters. Step-by-step instructions are not provided in this exercise. Instead, some very general
guidelines are outlined, and problem areas are highlighted and discussed. If you find this exercise to
be too difficult, we recommend that you go back and create either theMill or Lathe part again, but
don’t use the step-by-step instructions. Instead, work from the part print and use the tutorial text as
an aid if you get stuck.

This part provides a good example of determining whenGeometry Expert or free-formCAD should
be used to create certain shapes depending on how the part is dimensioned. The exercise also
highlights the differences between arcs and fillets and the issues involved with forward tangencies
in Geometry Expert.

For the part print for this exercise, see “Gear Housing” on page 166. The part print has four areas
that are circled and labeled. These are the particularly difficult areas that will be highlighted in this
exercise.

The part is composed primarily of three closed
shapes—the outside wall and two inside pockets.
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The outside wall, shown, can be createdmost
efficiently using Geometry Expert. The entire
outside shape can be created with Geometry
Expert, except for one point that must be created
using the free-formCAD tools.

The centerpoint for one of the outside arcsmust
be created in CAD; the dimensions of that point
can then be interrogated.

A combination of Geometry Expert and free-form
CAD is the best method for creating the larger
inside pocket shown.

The line labeled D must be created in CAD
because it is defined as being tangent to a circle
that is not part of the closed shape that contains
line D.

The smaller inside pocket shown is best created using only the free-formCAD tools becausemost
of the features that compose this shape are dimensioned with construction geometry.

For the outside shape, you should begin with the designated Start Feature (1.466" R arc), and
proceed around the shape in a clockwise direction. In this exercise, it will be very important to read
the prompting information, and to alsomake sure that the directions of the arcs and lines are
correct. Remember, line direction is indicated by the angle value.

Outer Shape

Area A is highlighted as a difficult section because this portion of geometry requires that a floating
line (line defined with only an angle) be tangent to the following feature, but not the previous
feature. This is an example of a forward tangency.



Exercise 3: Gear Housing

156

After creating the first arc, the
second feature (0.2" radius)
must be created as a counter-
clockwise arc rather than a
fillet.

A fillet cannot be used in this
case because the system
cannot calculate the fillet until
the intersection between the
preceding arc and following
line is complete.

1. Start Feature
2. 1.466 R
3. 0.200 R (TYP)
4. 0.187 DIA (TYP)

Because we only know the angle value of the following line the 0.2" radiusmust be defined as an
arc so that the following line has the necessary tangency points for its calculation. An arc with only a
radius value will be created tangent to the preceding and following features. These two features do
not have to intersect, and the arc with a radius value can be used to calculate following features. If
there was no radius between the first arc and the floating line, it would be necessary to enter an arc
with a radius of 0 in the spreadsheet in order for the system to correctly calculate the tangency of
the following line.

Area B is highlighted because the
centerpoint for the arcmust be created
using the free-formCAD tools and then
loaded into the Geometry Expert.

The only information that we have on that point is that it is rotated 60° to the right of the center point
of the top circle. Wewill need to create this point usingModify > Duplicate And... > 2D Rotate. Note
that theModifymenu is disabled whenGeometry Expert is open.

In order to draw the center point of the top circle, you will need to extract the center point. Reload
theGeometry Expert and load the shape. Interrogate the coordinates of the point as the centerpoint
of the next arc.
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Inner Shapes

AreasC and D are interrelated in that the line
designated in area D must be tangent to the
arc in area C.

It is recommended that the larger inside pocket (of which line D is a component) be created using a
combination of Geometry Expert and free-formCAD. The reason the entire shape cannot be
created using Geometry Expert is that line D is dimensioned as being tangent to an arc that is not
part of its shape, the circle contained in area C. It is best to create the shape in Geometry Expert
starting with the 1.340 R arc, and proceeding around in a clockwise direction. When you get to line
D, you will need to close the spreadsheet and use the free-formCAD tools.
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PART PRINTS
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Mill Tutorial
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Lathe Tutorial
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Shuttle
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Gear
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Shaft
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Chassis
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Doodle
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Gear Housing
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